
ECON 3150/4150 (Introductory Econometrics)

Problem sets

Spring 2004

This set consists of 11 problem sets, one for each seminar. Notice that some of the

problem sets consist of more than one problem. The first 3 problem sets should be prepared

by all students. Some of you will be asked to present your solution to each of the problems.

For the remaining problem sets, a group of students will prepare a solution that will be

handed out to the other students a few days before the seminar.
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Problem set 1

Problem 1

(i)

Let X,Y be stochastic variables and consider the realizations (xi, yi), i = 1, ..., n. Let

x = 1
n

Pn
i=1 xi and y = 1

n

Pn
i=1 yi. Show that the following relations must hold:

(a)
nX
i=1

(xi − x) = 0

(b)
nX
i=1

(xi − x) (yi − y) =
nX
i=1

(xi − x) yi =
nX
i=1

xi (yi − y)

(c)
nX
i=1

(xi − x) (yi − y) =
nX
i=1

xiyi − nx · y

The empirical correlation coefficient between X and Y is given by:

(d) r =

Pn
i=1 (xi − x) (yi − y)qPn

i=1 (xi − x)2
Pn

i=1 (yi − y)2

(ii) Use (c) and (d) to calculate r when

x = 2 y =
7

2
n = 6

nX
i=1

x2i = 106
nX
i=1

y2i = 103
nX
i=1

xiyi = 50

(iii) Let us define exi = xi−x
sx

and eyi = yi−y
sy

where sx and sy are the standard deviations

of x and y. Find the empirical mean and variance of the exi and eyi. Show that the empirical
correlation coefficient between exi and eyi will always be in the interval [−1, 1] (Hint: You can
use the fact that

Pn
i=1 z

2
i ≥ 0 is true for any variable z, and thus holds for zi = exi + eyi and

zi = exi − eyi respectively). This proof extends directly to the correlation coefficient between
any pair of un-standardized variables xi and yi. Why must this be true?
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Problem 2

Let X and Y be two stochastic variables.

(i) Show that if at least one of X and Y has expectation equal to zero, then

cov (X,Y ) = E (XY ) (1)

(ii) Use the result under (i) to calculate an expression for E (X2) when E (X) = 0.

(iii) Use the definition of covariance to show that

cov (AX + a,BY + b) = ABcov(X,Y )

when A, a,B, b are constants.

(iv) Use the definition of variance to show that

var(X + Y ) = var (X) + var (Y ) + 2Cov (X,Y )

var(X − Y ) = var (X) + var (Y )− 2Cov (X,Y )

(v)

The theoretical correlation coefficient between X and Y is defined by:

ρ =
cov (X ,Y )p

var (X)
p
var (Y )

Under problem 1 you established that the empirical correlation coefficient between to

variables xi and yi was always in the interval [−1, 1]. Use the result under (iv) to show
that the same must be true for the theoretical correlation coefficient between any pair of

stochastic variables X and Y .
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Problem set 2

Problem 1

Consider a population of households consisting of either one, two or three household

members above the age of 18 and assume that none of these households own more than

three cars in total. Let the variable X denote the number of household members and the

variable Y the number of cars owned by the household. The bivariate distribution of (X,Y )

is depicted in Table1 below.

TABLE 1

X / Y 0 1 2 3 Total

1 .28 .21 .01 .00 .5

2 .10 .16 .03 .01 .3

3 .04 .10 .04 .02 .2

Total .42 .47 .08 .03

Consider a random draw from this population and define the events A: "The number of

cars in the household is one" and B: "The number of household members is three".

(a) Find P (A) , P (B) , P (A|B) and P (B|A) .
(b) Calculate E (Y ) , E (Y |X = 1) , E (Y |X = 2) and E (Y |X = 3) .

(c) Calculate V AR (Y |X = 1) and V AR (Y ).

(d) Confirm that Ex (E (Y |X)) = E (Y ). Can you show that this will hold for any

bivariate distribution (X,Y )?

Problem 2

(a) Fig. 1 shows a plot of n = 42 realizations of bivariate distributed stochastic variables

X and Y . Explain how you could proceed to fit a straight line to the points in this dia-

gram. Do you find that the concept of "best linear fit" is well defined without any further

specifications?

(b) If ordinary least squares (OLS) is used to fit a straight line to the data points (Xi, Yi)
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i = 1, 2, ..., n then the fitted constant and slope parameters are given by:

bα = Y − bβX
bβ =

P¡
Xi −X

¢ ¡
Yi − Y

¢P¡
Xi −X

¢2
Show that if OLS instead is applied to fit a straight line to the data points (xi, Yi)

i = 1, 2, ..., n where xi = Xi −X, then the fitted constant and slope parameters are given

by:

eα = bα+ bβXeβ = bβ
(c) Suppose that the reason for your interest in the relationship between X and Y is your

confidence in an economic theory that suggests that we can write

Yi = α+ βXi + ui

where α and β are unknown constants and ui is an unobservable stochastic variable with

expectation zero and a constant variance. Moreover, assume that Xi can be treated as "fixed

in repeated sampling". Why should we turn to the particular method of OLS if the above

presumptions accurately describes the relation between X and Y and our interest is to draw

inference about the unknown parameters α and β?
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(d) Suppose X = 6.5211 and that we estimate bα = 15.6480 and bβ = −0.295719. How
would you estimate E (Y ) and E (Y |X = 10)?

(e) How is bβ related to the empirical coefficient of correlation between X and Y ?

(f) How would you characterize the difference between correlation analysis and regression

analysis?
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Problem set 3

(a) Use the "File->Open" menu in GiveWin. Choose to open the data file Data.in7,

which is located in "c:\Program files\Givewin2\". Use the "Tools-Graphics" menu to draw
a "Scatter plot" and an "Actual values plot" using the variables CONS (consumption) and

INC (income).

(b) Click the "Modules->Start-PcGive" menu to start the PcGive module. Use "Package-

>Descriptive statistics" to tell PcGive that we want to do descriptive statistics. Choose

"Model->Formulate" to select variables. Calculate the coefficient of correlation between

CONS and INC. In the Descriptive statistics check box you can choose the option "select

sample". Use this facility calculate the coefficient of correlation using data from 1953(1) to

1972(4) only.

(c) Choose "Calculator" from the "Tools" menu in GiveWin. Use this facility to generate

a new variable representing the first difference of the variable CONS (you can use the function

diff(CONS,1). You must assign a name to the new variable). Repeat the procedure for the

variable INC. Repeat the procedures under (b) using the first differences of CONS and INC

instead of the levels. Try to compare the results.

(d) Choose "Package->Econometric modelling" in PcGive to tell PcGive that we want to

run regressions. Then choose "Model->Cross section regression" as we want to use a static

model. Specify consumption to be the dependent variable and Income to be exogenous (ex-

planatory variable) and estimate the model with OLS. Do you find the estimated coefficients

in line with a priori expectations? In PcGive, choose "Test->Graphic analysis", and select

"Actual and fitted values", "Residuals" and "Residual density". Give a description of the

graphics you obtain. Repeat the analysis using the differenced variables. Do you find the

estimated coefficients in line with a priori expectations?

(e) Choose the calculator from the "Tools" menu in GiveWin and use the "dummy"

option to create a variable that takes the value zero in the period 1953(1)-1971(4) and the

value one 1972(1)-1992(4). Run the same regression as above except that now you add the

dummy as a second exogenous variable and interpret the results. Turn back to the calculator

and make a new variable that equals the product of Income and the dummy variable and

add this variable too to the list of explanatory variables. Run this regression and try to

interpret the results.
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(f) Repeat the analysis under (f) using the log of income and the log of consumption

(construct these variables using the calculator). Interpret the results.
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Problem set 4

Problem 1

In a study of wage differences between native and non-native workers of similar age and

training the following equation is estimated:

(1) Wi = α+ βDi + ui i = 1, 2, ..., n

where Wi is the wage of worker i and Di is a dummy variable that takes the value 1 only

if the worker is non-native and zero otherwise, and ui is a stochastic error term. Let Wnat

andWnon and nnat and nnon the average wage and number of natives and non-natives in the

study. Denote by W̄ and D̄ the average of Wi and Di.

(a) Show that the following relations holds:

(i) W =
nnonWnon + nnatWnat

n

(ii) D =
nnon

nnon + nnat

(iii)
nX
i=1

¡
Di −D

¢2
=

nnon · nnat
nnon + nnat

(b) Show that OLS on (1) gives bα =Wnat and bβ =Wnon −W nat. Interpret.

(c) For a given number of observations n, what is the share between natives and non-

natives that gives the most precise estimate of β?

Problem 2

You whish to investigate whether the relation between age and wage income is the same

for men and women. Suppose you have estimated the following relations:

(1) inci = α0 + α1agei + Ui i = 1, 2, ..., n

(2) inci = β0 + β1agei + γfemi + Vi i = 1, 2, ..., n

where inci is wage income, agei is age and Ui, Vi stochastic error terms. The variable femi

takes the value 1 if the observation unit i is of a female and zero if it is of a male. Below

the regression output from OLS applied to equation (1) and (2) is reproduced (EQ (1) and

EQ (2)). The estimation is done using income data on individuals between the age of 18
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and the age of 40 from Statistics Norway’s Survey of Income and Wealth.

(a) Review the estimated coefficients. What is the precise interpretation of the coefficient

γ?

(b) Test the hypothesis that the relationship between age and income is the same for men

and women.

(c) In the printout for EQ (3) an interaction term; age ∗ fem is included in the regres-

sion. Give an interpretation of the coefficient on this variable. Does the results add to our

understanding of the gender differences in the income-age relationship? How would you now

test the null hypothesis of no gender differences?

(d) In the printout for EQ (4) and EQ (5) the variable inci is replaced with the natural

log of inci. Give precise interpretations of the coefficients. Do you think this specification has

a better interpretation than the specification EQ (1) and EQ (2)? How could you proceed

to establish which specification that fit the data best?
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EQ( 1) Modelling inc by OLS

The estimation sample is: 1 to 12237

Coefficient Std.Error t-value t-prob Part.R^2

Constant -125862. 9347. -13.5 0.000 0.0146

age 10373.8 316.3 32.8 0.000 0.0808

sigma 242135 RSS 7.17328365e+014

R^2 0.0808074 F(1,12235) = 1076 [0.000]**

log-likelihood -169068 DW 1.1

no. of observations 12237 no. of parameters 2

mean(inc) 172161 var(inc) 6.3773e+010

EQ( 2) Modelling inc by OLS

The estimation sample is: 1 to 12237

Coefficient Std.Error t-value t-prob Part.R^2

Constant -100578. 9431. -10.7 0.000 0.0092

age 10536.8 313.8 33.6 0.000 0.0844

fem -62966.0 4349. -14.5 0.000 0.0168

sigma 240096 RSS 7.05242974e+014

R^2 0.0962938 F(2,12234) = 651.8 [0.000]**

log-likelihood -168964 DW 1.12

no. of observations 12237 no. of parameters 3

mean(inc) 172161 var(inc) 6.3773e+010
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EQ( 3) Modelling inc by OLS

The estimation sample is: 1 to 12237

Coefficient Std.Error t-value t-prob Part.R^2

Constant -190025. 1.273e+004 -14.9 0.000 0.0179

age 13676.2 434.4 31.5 0.000 0.0749

fem 124028. 1.849e+004 6.71 0.000 0.0037

fem*age -6504.33 625.3 -10.4 0.000 0.0088

sigma 239051 RSS 6.99060616e+014

R^2 0.104216 F(3,12233) = 474.4 [0.000]**

log-likelihood -168910 DW 1.13

no. of observations 12237 no. of parameters 4

mean(inc) 172161 var(inc) 6.3773e+010

EQ( 4) Modelling ln(inc) by OLS

The estimation sample is: 1 to 12237

Coefficient Std.Error t-value t-prob Part.R^2

Constant 9.03854 0.04021 225. 0.000 0.8051

age 0.0900940 0.001361 66.2 0.000 0.2638

sigma 1.04155 RSS 13272.9679

R^2 0.263816 F(1,12235) = 4384 [0.000]**

log-likelihood -17860.8 DW 0.437

no. of observations 12237 no. of parameters 2

mean(ln(inc)) 11.6268 var(ln(inc)) 1.47335
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EQ( 5) Modelling ln(inc) by OLS

The estimation sample is: 1 to 12237

Coefficient Std.Error t-value t-prob Part.R^2

Constant 9.15154 0.04054 226. 0.000 0.8064

age 0.0908225 0.001349 67.3 0.000 0.2703

fem -0.281393 0.01869 -15.1 0.000 0.0182

sigma 1.03208 RSS 13031.6017

R^2 0.277203 F(2,12234) = 2346 [0.000]**

log-likelihood -17748.5 DW 0.451

no. of observations 12237 no. of parameters 3

mean(ln(inc)) 11.6268 var(ln(inc)) 1.47335
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Problem set 5

Problem 1

(a)

Consider the model

(1) Yi = βXi + ui, i = 1, 2, ..., n

where ui is a stochastic variable with constant variance σ2 and expectation zero and

assume that X can be considered to be "fixed in repeated sampling". Explain how the

assumptions of the classical regression model relate to the Gauss-Markov theorem.

(b)

Show that the estimators

bβ =

P
XiYiP
X2

ieβ =

P
YiP
Xi

are both unbiased estimators of β in (1).

(c)

Calculate var
³bβ´ and var

³eβ´ and show that var ³bβ´ < var
³eβ´.

Problem 2

(a)

Explain how you would proceed to derive the OLS estimators for a, b and c in the model

Yi = a+ bxi + czi + ei, i = 1, 2, ..., n

where xi = Xi −X and zi = Zi − Z.

(b) Use the normal equations to show that the residuals and the explanatory variables

are empirically uncorrelated and that the sum of the residuals equal zero.
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(c) The variances of the OLS estimators bb and bc are given by
var

³bb´ =
σ2P

x2i − (
P

xizi)
2P

z2i

var (bc) =
σ2P

z2i − (
P

xizi)
2P

x2i

where σ2 is the (theoretical) variance of the error term. What happens to the variance

of the estimators bb and bc as the empirical correlation between X and Z approaches 1?
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Problem set 6

Using quarterly consumption and income data for Norway over the period 1971(1) to

1994(2) an investigation has estimated the log linear consumption function to be

byt = −0.59 + 1.05xt

(a) Show that the the savings rate is approximately equal to x−y, where x and y denotes
the natural logarithm of income and consumption (hint: ln(x+ 1) ≈ x when x is small). Use

the results reproduced in Table 1 to test whether the savings rate is independent of income.

Table 1

Coef Stdev t-ratio p

Constant −0.58510 0.4506 −1.298 0.1974

xt 1.0496 0.040056 26.203 0.0000

s = 0.061105 R2 = 0.882 RSS = 0.3435 DW = 1.82

(b) Since we are using quarterly data in our analysis we would like to check for seasonal

differences. Define a dummy variable

Dit =

⎧⎨⎩ 1 if the observation belongs to quarter i

0 otherwise

where i = 1, 2, 3. The results from the estimation is reproduced in Table 2.

Table 2

Coef Stdev t− ratio p

Constant −0.3563 0.3355 −1.06 0.2912

xt 1.0349 0.0297 34.77 0.0000

D1t −0.1157 0.0132 −8.76 0.0000

D2t −0.0583 0.0132 −4.40 0.0000

D3t −0.0758 0.0133 −5.68 0.0000

s = 0.045196 R2 = 0.937 RSS = 0.1817 DW = 0.54
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(c) Give an interpretation of the estimated coefficients. Are the results in line with your

a priori expectations?

(b)Why is only 3 seasonal dummy variables used and not one for each of the 4 seasons?

(d) Does the results indicate significant seasonal variation in the income - consumption

relationship?

In Table 3 the results from a regression where the natural logarithm of household wealth,

w is added to the list of explanatory variables.
Table 3

Coef Stdev t− ratio p

Constant 0.996 0.170 5.853 0.000

xt 0.567 0.028 19.666 0.000

wt 0.297 0.016 18.376 0.000

D1t −0.121 0.006 −19.941 0.000

D2t −0.078 0.006 −12.752 0.000

D3t −0.084 0.006 −13.752 0.000

s = 0.0206661 R2 = 0.987 RSS = 0.0375 DW = 1.29

(e) Does the results in table 3 alter your conclusion on whether the savings rate is

independent of aggregate income?

(f) Test the hypothesis that consumption is homogenous of degree one in income and

wealth. You may want to know that the covariance between the income and wealth coeffi-

cient is estimated to be −0.0004111.
(g) What is meant by the statement that the explanatory variable(s) in a regression is

exogenous? Can you find any objections to the assumption of exogeneity of the income

variable in single equation consumption regressions?
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Problem set 7

Open the file growth.xls, available on the course homepage, in GiveWin. The data

contains the following variables:

CtryName Country Name

wbctry World Bank country code

asiae East Asia dummy

laam Latin America dummy

oecd OECD dummy

safrica Sub-Saharan Africa dummy

human60 Average schooling 1960

human70 Average schooling 1970

humanm60 Average schooling men 1960

humanm70 Average schooling men 1970

humanf60 Average schooling women 1960

humanf70 Average schooling women 1970

lifee060 Life exp ectancy 1960

lifee070 Life exp ectancy 1970

gpop6085 Average popu lation growth1960-1985

gpop7085 Average popu lation growth 1970-1985

geetot60 Gov exp. on education/GDP 1960-1985

geetot70 Gov exp. on education/GDP 1970-1985

tot60 Average term s of trade 1960-1985

tot70 Average term s of trade 1970-1985

bmp60 Average black market prem ium 1960-90

bmp70 Average black market prem ium 1970-90

lgdp60 Log real GDP/capita 1960

lgdp70 Log real GDP/capita 1970

lgdp89 Log real GDP/capita 1989

inv6089 Average investments 1960-89

inv7089 Average investments 1970-89

demo60 Democracy score 1960

demo70 Democracy score 1970

(All variables are measured so that the size of the country does not matter.)

(a) Standard growth theory (such as the Solowmodel) predicts that growth should decline

as a country grows richer. Explain briefly why. Use the data set and construct a variable

that contains the change in log GDP per capita between 1970 and 1989. Test whether the

data support the hypothesis of convergence in income between countries. Show the estimated

relationship in a diagram and discuss.

(b) Empirical studies of growth often analyze conditional convergence. This means that

countries that differ by other attributes than income, such as savings rates and population

growth, will converge to different steady states. Hence to study convergence, we cannot

simply regress growth on GDP/cap, but should also include variables to control for different
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steady states. Repeat the study of convergence above including measures of population

growth and investments (to control for the savings rate). Compare with your previous

results. Do you get results that are closer to the theoretical predictions?

(c) Newer theories of growth emphasize the importance of human capital as a source of

growth. Try to establish to what extent the stock of human capital in 1970 (average years of

schooling) influences rates of growth. Is there any statistically significant difference between

the impact of men’s and women’s human capital on growth?

(d) The residual from the regressions above is usually interpreted as (among others)

unexplained technological progress. To explain some of these differences, Barro has suggested

including a larger number of explanatory variables in growth regressions and interpreting

these as effect on technological progress or productivity. Such analyses are often called “Barro

regressions”. Discuss the effect of life expectancy, government expenditures on education,

terms of trade, and democracy (which is an index going from —10 to 10) and discuss how

the results help us to explain the determinants of growth. You could also experiment with

including only some of these variables at a time.

(e) Suppose there is evidence that savings behavior depend on income. How does this

knowledge affect your estimates of the effect of investments rates in exercise (b)?
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Problem set 8

According to simple asset pricing theory the following relation can be used to determine

equilibrium financial asset prices:

(1) E (r) = rf + β (E (rm)− rf)

In equation (1) r is the rate of return on an asset, rf is the risk free rate of return and rm

is an index of asset returns where each asset is weighted by its market share. The parameter

β is called the asset’s beta value and is defined by:

(2) β ≡ cov (r, rm)

var (rm)

where cov (r, rm) is the theoretical covariance between r and rm and var (rm) is the

theoretical variance of rm.

(a) Assume that you have monthly observations of r, rf and rm and want to estimate the

beta value of the asset in question. Use equation (3) to confirm that b = β provided that

the condition cov (ut, rmt) = 0 holds. Discuss under which conditions you would prefer to

apply the method of OLS to estimate the beta value.

(3) rt = a+ brmt + ut, t = 1, 2, ..., T

(b) In the output for EQ (1) the regression model is applied on data on a Norwegian

mutual fund over the period 1996 (1) − 2002 (12). Construct a 95% confidence interval for

the beta value of the stock. Can the confidence interval be used to test whether the beta

value is different from one? What does the model given in equation (1) predict for the

expected return on an asset with beta equal to one?

(c) Explain what is meant by the R2 of the regression. Use the definition of R2 to

comment on the following claims:

(i) "Two assets with the same R2 must have the same empirical beta value."

(ii) "The empirical beta value must be less than one if the total variation of assets returns
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of the asset is less than that of the market index."

(d) For the empirical beta value of an asset to be a useful measure for the evaluation of

an asset, the parameters in (3) must be relatively constant over time. The output for EQ(2)

shows the results from OLS on

(4) a+ a1 ·D + b · rmt + b1 ·D · rmt + ut , t = 1, 2, ..., T

where the variable D is a dummy that equals 1 if t > 2000 (12) and zero otherwise. What

is the specified constant term and slope coefficient before and after December 2000 according

to this specification? How would you proceed to test whether the beta value were the same

in the two sub periods? The output in EQ (3) shows the results from a similar regression

where the variable D is substituted for a variable K that equals 1 when rm is negative and

zero otherwise. Could the results from this regression cast light on your interpretation of

results from the previous test?

(e) Suppose that we use the specification in (3) to estimate beta values for N assets

and have denoted the estimated beta values β∗1, β
∗
2, β

∗
3, ..., β

∗
N . Let ri be the average annual

return of asset i over the period and assume that we can write ri = E (ri) + εi where εi is a

stochastic variable and E (ri) is defined as E (r) in equation (1). Give an interpretation of

the coefficients γ0 and γ1 in the regression:

(5) ri = γ0 + γ1β
∗
i + εi , i = 1, 2, ..., N

where the estimated beta values is used as an explanatory variable. In the output for EQ (4)

you find the results from this specification applied on 30 Norwegian mutual funds. Do you

find the results plausible considering that the average return on the market index and the

risk free rate was estimated to equal 19% and 4.5% p.a. over the same period?

(f) It has been suggested that more factors than the beta value are influential in deter-

mining an equilibrium asset price. If this critique is warranted, how could it have affected

the estimate of γ1 in EQ (4)? In EQ (5) the results from the the following regression is

reproduced:

(6) ri = γ0 + γ1β
∗
i + γ2Zi + ei, i = 1, 2, ..., N
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where Zi = 1 − R2i and R2i is the R
2 from the estimation of the beta value of public fund

i. Can this regression cast light on whether other factors than the beta value are likely to

influence the expected return on the financial assets we investigate?
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EQ(1) Modelling r by OLS

The estimation sample is: 1996 (1) to 2002 (12)

Coefficient Std.Error t-value t-prob Part.R^2

Const -0.001832 0.00156 -1.17 0.245 0.0165

rm 0.927040 0.02404 38.6 0.000 0.9477

sigma 0.01430 RSS 0.0167914935

R^2 0.94772 F(1,82) = 1487 [0.000]**

log-likelihood 238.553 DW 2.23

no. of observations 84 no. of parameters 2

mean(r) 0.001671 var(r) 0. 00382426

EQ(2) Modelling r by OLS

The estimation sample is: 1996 (1) to 2002 (12)

Coefficient Std.Error t-value t-prob Part.R^2

Const -0.00022 0.001794 -0.124 0.902 0.0002

D -0.00147 0.003392 -0.436 0.664 0.0024

rm 0.86355 0.02949 29.3 0.000 0.9146

D*rm 0.15989 0.04859 3.29 0.001 0.1192

sigma 0.0135461 RSS 0.0146798308

R^2 0.954302 F(3,80) = 556.9 [0.000]**

log-likelihood 244.197 DW 2.14

no. of observations 84 no. of parameters 4

mean(r) 0.0016714 var(r) 0.00382426
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EQ(3) Modelling r by OLS

The estimation sample is: 1996 (1) to 2002 (12)

Coefficient Std.Error t-value t-prob Part.R^2

Const -0.0036 0.003009 -1.20 0.233 0.0177

rm 0.9683 0.05787 16.7 0.000 0.7778

K 0.0004 0.001888 0.217 0.829 0.0006

K*rm -0.0659 0.07801 -0.845 0.400 0.0089

sigma 0.0144164 RSS 0.0166265038

R^2 0.948242 F(3,80) = 488.6 [0.000]**

log-likelihood 238.967 DW 2.24

no. of observations 84 no. of parameters 4

mean(r) 0.00167141 var(r) 0.00382426

EQ(4) Modelling ri by OLS

The estimation sample is: 1 to 30

Coefficient Std.Error t-value t-prob Part.R^2

Const -0.11464 0.1204 -0.953 0.349 0.0314

beta 0.33561 0.1241 2.70 0.011 0.2072

sigma 0.0685029 RSS 0.131394017

R^2 0.20718 F(1,28) = 7.317 [0.011]*

log-likelihood 38.893 DW 1.39

no. of observations 30 no. of parameters 2

mean(ri) 0.209138 var(ri) 0.00552433
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EQ(4b) Modelling ri-rf by OLS

The estimation sample is: 1 to 30

Coefficient Std.Error t-value t-prob Part.R^2

beta 0.171920 0.01306 13.2 0.000 0.8566

sigma 0.0693943 RSS 0.139651436

log-likelihood 37.9789 DW 1.51

no. of observations 30 no. of parameters 1

mean(ri-rf) 0.164138 var(ri-rf) 0.00552433

EQ(5) Modelling ri by OLS

The estimation sample is: 1 to 30

Coefficient Std.Error t-value t-prob Part.R^2

Const 0.04410 0.06283 0.702 0.489 0.0179

beta 0.10346 0.06722 1.54 0.135 0.0807

z 0.46686 0.05089 9.17 0.000 0.7571

sigma 0.0343816 RSS 0.0319165568

R^2 0.807418 F(2,27) = 56.6 [0.000]**

log-likelihood 60.1193 DW 2.16

no. of observations 30 no. of parameters 3

mean(ri) 0.209138 var(ri) 0.00552433
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Problem set 9

Consider a household which consume food in quantum m and other goods in quanta x at

prices p and 1 respectively. Assume that the preferences of the household can be represented

as:

(1) U (m,x) = (m−m)β x1−β

for 0 < β < 1. The household has an exogenously given income y.

(a) Solve the maximization problem of the household and show that optimal expenditure

on food can be written as

(2) pm = (1− β) pm+ βy

Give an economic interpretation of the parameter m.

(b) The output for EQ (1) reproduces the results of the regression

(3) Yi = α+ βXi + ui

where Yi is expenditure on food and Xi is total expenditure, both measured in Norwegian

Kroner. Interpret the coefficients. Define the budget share of food expenditures as food

expenditure divided by total expenditure. Find an expression for this measure and estimate

it for the average household.

(c) Engel’s law suggests that the budget share of food expenditures is decreasing in the

households’s income. Test whether this hypothesis holds for our model.

(d) The Engel elasticity is defined as the elasticity of the expenditure on a commodity

with respect to income. Find an expression that gives the Engel elasticity using the demand

equation given in (2) and estimate it for a household with average income.

(e) The analysis so far has not taken into account that households’ of different sizes

could have different levels of "minimum food expenditure". Assume we can write

(4) m = m0 +m1N

where N is the number of household members. Show how this assumption introduces N as

an explanatory variable. Can you estimate the parameters m0 and m using the regression

26



results reproduced in EQ (2)?

(f) Calculate the Engel elasticity for households with one and two household members

respectively (you can still use average household expenditure).

(g) In the regression reproduced in output EQ (3) there is a difference in the treatment

of adults over the age of 16 and children. Interpret the coefficients. Test whether children

and adults influence household expenditure on food differently. Can we say that children

and adults have different needs for food?

(h) The data used in this problem are available on the course homepage. Open these

data in PcGive and discuss whether the specification in (3) is a good one. Try to estimate

some other specifications of Engel curves (relationships between expenditure and income).

Are any of your specifications better than (3)?
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Variable Label N Mean Std Dev

totexp Total expenditure 1311 256989.86 142751.20

Hhmemb # houshold members 1311 3.2196796 1.3571221

child # children 1311 1.0114416 1.1387781

adults # adults 1311 2.2082380 0.8243207

EQ( 1) Modelling Food by OLS

The estimation sample is: 1 to 1311

Coefficient Std.Error t-value t-prob Part.R^2

Constant 19777.4 1274. 15.5 0.000 0.1555

Totexp 0.0692542 0.004334 16.0 0.000 0.1632

sigma 22392.9 RSS 6.56386112e+011

R^2 0.16322 F(1,1309) = 255.3 [0.000]**

log-likelihood -14990.9 DW 2.06

no. of observations 1311 no. of parameters 2

mean(food) 37575 var(food) 5.98337e+008
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EQ( 2) Modelling Food by OLS

The estimation sample is: 1 to 1311

Coefficient Std.Error t-value t-prob Part.R^2

Constant 6234.48 1593. 3.91 0.000 0.0116

Totexp 0.0458978 0.004465 10.3 0.000 0.0748

HhMemb 6070.56 469.6 12.9 0.000 0.1133

sigma 21094.6 RSS 5.82035478e+011

R^2 0.258005 F(2,1308) = 227.4 [0.000]**

log-likelihood -14912.1 DW 2.05

no. of observations 1311 no. of parameters 3

mean(food) 37575 var(food) 5.98337e+008

EQ( 3) Modelling Food by OLS

The estimation sample is: 1 to 1311

Coefficient Std.Error t-value t-prob Part.R^2

Constant 868.502 1818. 0.478 0.633 0.0002

Totexp 0.0439255 0.004421 9.94 0.000 0.0702

child 4517.96 533.5 8.47 0.000 0.0520

adults 9441.22 736.9 12.8 0.000 0.1116

sigma 20828.5 RSS 5.67008498e+011

R^2 0.277162 F(3,1307) = 167 [0.000]**

log-likelihood -14894.9 DW 2.05

no. of observations 1311 no. of parameters 4

mean(food) 37575 var(food) 5.98337e+008
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Problem set 10:

Problem 1:

Let

Yt = a+ bxt + ut, t = 1, 2, ..., T

where xt = Xt −X,and a and b are constants and ut is the error term. After you have

estimated a and b you are interested in constructing a prediction for a future value Yp and

evaluate the uncertainty of this prediction.

(a) Calculate expectation and variance of the prediction error F = bYp − Yp when you

assume that you know the future value of the explanatory variable xP .

(b) Show how you would proceed to construct a 100 (1− α)% prediction interval for Yp.

What is the difference between a confidence interval for E (Y ) and a prediction interval for

Y ? When are the intervals at the narrowest? When is the confidence interval for E (Y )

equivalent with a confidence interval for a?

(c) Load Data.in7 in GiveWin and use PcGive to estimate a consumption function using

the variables CONS and INCOME when you let the sample end at 1991 (3). Use PcGive

to calculate the point prediction for CONS and 95% prediction intervals for the period

1991 (4)− 1992 (3).
(d) Assume the model is of the form

Yt = a+ bxt + czt + ut, t = 1, 2, ..., T

and repeat the exercises under (a) and (b).

(e) Load Data.in7 in GiveWin and use PcGive to estimate a consumption function where

you add lagged consumption to the list of explanatory variables. What is the immediate

effect on consumption of an increase in income according the estimates you obtain? What

is the long term effect of an increase in income?

Problem 2:

Suppose you want to estimate the demand for coffee in a specific geographic region by

the simple linear regression;

Xt = c+ bPt + et
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where Xt is the total amount of coffee sold in the region and Pt is the world price per kilo at

time t. Unfortunately the appropriate price-quantum data needed to run the regression are

not available. However, from a previous study using quarterly data over the last 12 years

you have been able to establish that the correlation between price and quantum over the

period were −0.856, mean price and quantum 0.6103 and 617.2, and the standard deviations
0.3765 and 40.76, respectively.

(a) Use the available information to calculate OLS estimates of c and b.

(b) Explain what is meant by the regression’s "R-squared" and calculate R-squared us-

ing the available information. Find an estimate of σ (the standard deviation around the

population regression line).

(c) Establish whether your estimate of b is significantly different from zero.

(d) Next quarter the price of coffee is suspected to rise sharply to 2.5 due to unfortunate

wether conditions that has resulted in a supply shock. Give an estimate of the next quarter’s

price elasticity and compare it with the price elasticity at the mean price over the estimation

period. Explain why these elasticities differ.
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Problem set 11:

Problem 1

In this assignment you will investigate whether expenditure on housing and furniture

depends on the households income and the number of children in the household. For a

cross-section of households we have observed the following variables; expenditure on housing

and furniture (Yi), income (Xi) and the number of children (Ni). We are uncertain on

the appropriate functional form for the regression and thus we have experimented with two

different specifications:

(1) Yi = β0 + β1Xi + εi

(2) Yi = γ0 + γ1Xi + γ2Ni + γ3N
2
i + ui

In both regressions we assume that the explanatory variables are exogenous and that

the stochastic error terms εi and ui is distributed according to the assumptions of classical

regression analysis.

(a) Give a comment on the regression results EQ (1) and EQ (2) reproduced below.

(b) Explain how you would proceed to test the hypothesis that expenditure on housing

and furniture is independent of income.

(c) The mean income in the sample X amounts to NOK 73010. Use the results from

the estimation of (1) to calculate a prediction interval for the expenditure on housing for a

household with income equal to 100000 using a confidence coefficient of 0.9.

(d) Why will calculation of a prediction interval be more involved if you choose to base

the analysis in the estimated equation (2)?

(e) Explain why the effect of income on expenditure on housing and furniture is different

in the two specifications (1) and (2) ?

(f) The regression results suggests that the number of children does have some effect on

the households’ expenditure on housing and furniture. Inspect this more formally by testing

the hypothesis "γ2 = γ3 = 0” against "at least one of γ2 and γ3 are nonzero". You can use

significance level α = 0.5 for your test. Comment the results. Consider the slightly different

specification;

(3) ln (Yi) = τ 0 + τ 1Xi + τ 2Ni + τ 3N
2
i + vi
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(h) How do you interpret τ 1 in this regression?

(i) Review the results of the regression on the specification in (3) reproduced in printout

EQ (5) and quantify the effect on expenditure of a marginal increase in the number of children

for a family with one child and for a family with three children. Compare the results with the

corresponding results for regression (2) reproduced in the printout EQ (2) and comment.

(j) Suppose the expenditure was data gathered employing a poorly constructed question-

naire and thus the expenditure data has a tendency to be erroneous. One way to model this

situation is to consider the true expenditure variable Yi as unobserved and to represent the

registered expenditure as Qi = exp (ωi)Yi where ωi is a random variable with expectation 0

and variance σ2w. How will the estimated coefficients be influenced by the fact that you use

ln (Qi) as regressand instead of ln (Yi) as prescribed by equation (3)?
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EQ1: The regression equation is

Y = 13.8 + 0.216X

Predictor Coef Stdev t-ratio p

Constant 13.761 6.593 2.09 0.046

X 0.21649 0.08272 2.62 0.014

s = 14.48 R-sq = 19.7% R-sq(adj) = 16.8%

Analysis of Variance

SOURCE DF SS MS F p

Regression 1 1435.3 1435.3 6.85 0.014

Error 28 5867.8 209.6

Total 29 7303.1

EQ2: The regression equation is

Y = 12.2 + 0.168X + 14.5N - 4.11 N2

Predictor Coef Stdev t-ratio p

Constant 12.170 6.242 1.95 0.062

X 0.16759 0.08654 1.94 0.064

N 14.501 6.306 2.30 0.030

N2 -4.109 1.724 -2.38 0.025

s = 13.61 R-sq = 34.1% R-sq(adj) = 26.5%

Analysis of Variance

SOURCE DF SS MS F p

Regression 3 2490.5 830.2 4.48 0.012

Error 26 4812.6 185.1

Total 29 7303.1
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EQ3: The regression equation is

N = 0.195 + 0.0160X

Predictor Coef Stdev t-ratio p

Constant 0.1953 0.5649 0.35 0.732

X 0.016043 0.007088 2.26 0.032

s = 1.240 R-sq = 15.5% R-sq(adj) = 12.4%

Analysis of Variance

SOURCE DF SS MS F p

Regression 1 7.883 7.883 5.12 0.032

Error 28 43.084 1.539

Total 29 50.967

EQ4: The regression equation is

N2 = 0.30 + 0.0447X

Predictor Coef Stdev t-ratio p

Constant 0.302 2.066 0.15 0.885

X 0.04471 0.02592 1.73 0.096

s = 4.536 R-sq = 9.6% R-sq(adj) = 6.4%

Analysis of Variance

SOURCE DF SS MS F p

Regression 1 61.23 61.23 2.98 0.096

Error 28 576.14 20.58

Total 29 637.37
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EQ5: The regression equation is

lnY = 2.51 + 0.00807X + 0.459N - 0.135N2

Predictor Coef Stdev t-ratio p

Constant 2.5096 0.2153 11.65 0.000

X 0.008066 0.002986 2.70 0.012

N 0.4586 0.2175 2.11 0.045

N2 -0.13482 0.05949 -2.27 0.032

s = 0.4693 R-sq = 40.1% R-sq(adj) = 33.2%

Analysis of Variance

SOURCE DF SS MS F p

Regression 3 3.8365 1.2788 5.81 0.004

Error 26 5.7272 0.2203

Total 29 9.5638
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